BRAUMAT

HMI Design Guide

BRAUMAT with STEP 7

Warranty and liability

Note

The Application Examples are not binding and do not claim to be complete regarding the circuits shown, equipping and any eventuality. The Application Examples do not represent customer-specific solutions. They are only intended to provide support for typical applications. You are responsible for ensuring that the described products are used correctly. These application examples do not relieve you of the responsibility to use safe practices in application, installation, operation and maintenance. When using these Application Examples, you recognize that we cannot be made liable for any damage/claims beyond the liability clause described. We reserve the right to make changes to these Application Examples at any time without prior notice.

If there are any deviations between the recommendations provided in these application examples and other Siemens publications – e.g. Catalogs – the contents of the other documents have priority.

We do not accept any liability for the information contained in this document.

Any claims against us – based on whatever legal reason – resulting from the use of the examples, information, programs, engineering and performance data etc., described in this Application Example shall be excluded. Such an exclusion shall not apply in the case of mandatory liability, e.g. under the German Product Liability Act ("Produkthaftungsgesetz"), in case of intent, gross negligence, or injury of life, body or health, guarantee for the quality of a product, fraudulent concealment of a deficiency or breach of a condition which goes to the root of the contract ("wesentliche Vertragspflichten"). The damages for a breach of a substantial contractual obligation are, however, limited to the foreseeable damage, typical for the type of contract, except in the event of intent or gross negligence or injury to life, body or health. The above provisions do not imply a change of the burden of proof to your detriment.

Any form of duplication or distribution of these Application Examples or excerpts hereof is prohibited without the expressed consent of Siemens Industry Sector.

Security information

Siemens provides products and solutions with industrial security functions that support the secure operation of plants, solutions, machines, equipment and/or networks. They are important components in a holistic industrial security concept. With this in mind, Siemens’ products and solutions undergo continuous development. Siemens recommends strongly that you regularly check for product updates.

For the secure operation of Siemens products and solutions, it is necessary to take suitable preventive action (e.g. cell protection concept) and integrate each component into a holistic, state-of-the-art industrial security concept. Third-party products that may be in use should also be considered. For more information about industrial security, visit http://www.siemens.com/industrialsecurity.

To stay informed about product updates as they occur, sign up for a product-specific newsletter. For more information, visit http://support.automation.siemens.com.
Table of contents

1 Introduction ........................................................................................................ 4
  1.1 Intended Audience .................................................................................. 4
  1.2 Scope .................................................................................................... 4
  1.3 Further Reading ................................................................................... 4

2 HMI and Interfaces ............................................................................................. 5
  2.1 Operator station clients (OS clients) ..................................................... 5
  2.2 Batch control ........................................................................................ 5
  2.3 Route control center (RouteCC) ........................................................... 5

3 BRAUMAT Process Images .............................................................................. 6
  3.1 Overview Area ...................................................................................... 7
  3.2 Navigation between the process images ............................................. 10
    3.2.1 General navigation ........................................................................ 10
    3.2.2 Going backwards ......................................................................... 11
    3.2.3 Navigation panel .......................................................................... 11
  3.3 BRAUMAT Process Image File Structure ............................................. 12
    3.3.1 Tag Types available in BRAUMAT ............................................. 12
  3.4 Faceplates .......................................................................................... 12
    3.4.1 Unit Control Faceplate (for sequences) ........................................ 12
    3.4.2 RCS Faceplate (for route control) ............................................... 14
    3.4.3 Individual Control Elements (ICM) faceplate ................................ 16

4 Alarm System ................................................................................................... 17
  4.1 Overview ............................................................................................. 17
  4.2 Message Control Faceplate .................................................................. 18
    4.3.1 Message types ............................................................................. 18
    4.3.2 Message encoding ........................................................................ 19
  4.4 Message archive ................................................................................ 20

5 Curve visualization: "Trends" ........................................................................ 21
  5.1 Types of Trends ............................................................................... 21
  5.2 Selection of Trends ........................................................................... 21

6 Starting and Watching Recipes ...................................................................... 23
  6.1 The Batch Scheduler .......................................................................... 23
    6.1.1 Creating an Order with the Batch Scheduler .............................. 23
    6.1.2 Starting an Order ........................................................................ 24
    6.1.3 Supervising Batches with the Batch Scheduler ......................... 24
  6.2 Watching Recipes with the Control Recipe Editor ............................... 26

7 Development of Process Pictures ................................................................. 28
  7.1 File Structures for BRAUMAT Process Pictures .............................. 28
  7.2 Creating a Tag List .............................................................................. 28
  7.3 Background Image and Predefined Static Objects ............................ 28
    7.3.1 Using Layers in Graphics Designer ............................................ 29
    7.3.2 Image resolution of process pictures ......................................... 29
    7.3.3 Substance and piping graphics conventions ................................ 29
    7.3.4 Process connectors .................................................................... 30
    7.3.5 Static Texts .................................................................................. 31
    7.3.6 Static Process Objects ................................................................ 31
    7.3.7 File conversion between applications ....................................... 38

8 History ............................................................................................................. 42
1 Introduction

This document contains a description of the HMI features BRAUMAT OS provides. After some explanations of the chosen monitoring and control philosophy of BRAUMAT this document defines the configuration of static and dynamic objects with the relevant GUI dialogs to satisfy user requirements for monitoring and operation of a process.

1.1 Intended Audience

This document is aimed at personnel configuring HMI projects with BRAUMAT. It is not primarily geared towards operators of BRAUMAT installations.

1.2 Scope

The HMI Design Guide shows and defines:
- General user interfaces
- Screen layouts
- Appearance of messages and trends
- Static equipment
- Basic dynamic equipment

Additionally the HMI Design Guide defines the BRAUMAT OS-relevant adjustments for:
- Language conventions
- Basic setups
- OS redundancy settings
- Alarm logging
- Tag logging
- User administration
- Time synchronization
- Audible and visible alarms

Outside of the scope are detailed technical explanations about the BRAUMAT OS part and dynamic equipment. This information is found in technical data sheets, the control module specification and installation procedures.

1.3 Further Reading

This document is complemented by the BRAUMAT Operator Manual which contains additional information for interested readers, especially plant operators.
2 HMI and Interfaces

Introduction
This chapter describes the Human Machine Interface and further interfaces that are used in the project. It contains information about all visualization aspects of the system like images and trends, the operation concept, the event and message concept and data archiving.

Components
The user interface consists of three major components:
• Operator station clients (OS clients) (see 2.1)
• Batch control (see 2.2)
• Route control center (RouteCC) (see 2.3)

2.1 Operator station clients (OS clients)
Features
• Monitoring and controlling of the process by calling up general or detailed process images
• Faceplates for:
  - controlling various equipment items
  - message lists for analyzing current and historical alarms, exceptions and events
  - the display of trend data

2.2 Batch control
Features
• Starting batches
• Viewing of detailed information about batches
• Opening control recipes to monitor the progress of running batches
• Controlling running batches in order to hold, resume, start or change set points
• Display of batch report information on the OS stations

2.3 Route control center (RouteCC)
Features
General and detailed information about the status of routes and transfers under the operation of Simatic Route Control.
3 BRAUMAT Process Images

BRAUMAT process images are divided into three main areas:

- **Overview**: the top segment of the screen consisting of two overview area panels (see 3.1, Overview Area):
  - Message control faceplate
  - Unit faceplates and Smart unit faceplates

- **The process image**: This is the center part and main working area

- **Task bar**: “Panel control” bottom segment of the window (see 3.1, Task Bar)

A typical BRAUMAT process image is depicted here:

![Figure 3-1](image)

The features of these BRAUMAT controls are briefly explained below.
3.1 Overview Area

The Overview area contains:

- The Message control faceplate with a specific message filter
- A $4 \times 4$ matrix of smart unit controls composing the overview area body (may be adapted to project demands)

Message Control Faceplate

The Message control faceplate contains a programmable message filter in order to allow unit-specific message display in a process image.

A logical expression which compares different fields is used to filter the messages which are only shown when the filter matches. The fields can be selected from a list of field identifiers in the left of the dialog window.

Figure 3-2
Smart Unit Control

The smart unit control offers navigation to all unit-relevant issues. The smart unit control is connected to the unit by the selection of:

- The PCU handling the unit
- The unit object inside the PCU
- Additionally an image can be selected to be shown in the process image.

The selected image will open upon selection.

Figure 3-3
Task Bar

The task bar offers functionality in different tabs:

- “Navigation panel” for configurable navigation through images (see 3.2.3 Navigation panel)
- “Application panel” containing a programmable list of applications (including BRAUMAT) which can be launched from here
- “Time panel” controlling the date/time information and format used for display

Figure 3-4

NOTE

The term “panel control” is sometimes used synonymously with “task bar.”
3.2 Navigation between the process images

3.2.1 General navigation

There are various means to navigate between the pictures of a project:

Table 3-1

<table>
<thead>
<tr>
<th>No</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Use the application “Process diagrams”</td>
</tr>
<tr>
<td><img src="image1.png" alt="Image" /></td>
<td><img src="image2.png" alt="Image" /></td>
</tr>
<tr>
<td>2.</td>
<td>Click on the navigation buttons in the pictures provided they have been configured</td>
</tr>
<tr>
<td><img src="image3.png" alt="Image" /></td>
<td><img src="image4.png" alt="Image" /></td>
</tr>
<tr>
<td>3.</td>
<td>Click on the menu item „Open image“ which allows the loading of external pictures</td>
</tr>
<tr>
<td><img src="image5.png" alt="Image" /></td>
<td><img src="image6.png" alt="Image" /></td>
</tr>
</tbody>
</table>
3.2.2 Going backwards

To move back to the previously visited screen click on the icon highlighted to the right or use the key combination "Ctrl" + "F12".

Figure 3-5

3.2.3 Navigation panel

The navigation panel faceplate allows you to navigate through the images and image areas.

Features

- Direct jump to the starting page
- Direct selection of process images (brewing house, fermenting area,...)
- Direct selection of images
- Jump to the next or previous image in an image block
- Execution of BRAUMAT applications

Right-click on the navigation field to receive additional information.

Figure 3-6

Click on the highlighted icon to move to the plant overview.

Figure 3-7
3.3 BRAUMAT Process Image File Structure

Each BRAUMAT process image consists of a background image and a tag type file.

3.3.1 Tag Types available in BRAUMAT

BRAUMAT offers a large amount of tag types. The most important among these are:

- Elementary variables like analogue or digital values, text lists, sounds, bars, pipes, image selectors
- Individual control modules (ICM), PID-Controls
- Faceplates, primarily unit-, Route Control RCC-panel and ICM-faceplate. Faceplates are the most important tags to be implemented on BRAUMAT process images
- Executing (starting an exe-file on the operating system level or starting a function (FC) or function block (FB) on AS-level)

3.4 Faceplates

Faceplates are pop-up windows that appear when the user left-clicks on an object on the image such as a valve or pump. Faceplates can also be opened by using the “Tag Browser” button on the button bar. The resulting pop-up window can be used to issue commands to the device and to switch between automatic and manual mode.

3.4.1 Unit Control Faceplate (for sequences)

For the operation and monitoring of the state of a sequence, a special faceplate can be activated in the process picture.

Symbolic representation in the process-picture

The "Unit Control" can be represented symbolically in several ways:

- Line representation
- Window display by clicking the corresponding icon
Line representation

The line representation of a unit control appears as below:

Figure 3-9

<table>
<thead>
<tr>
<th>SID</th>
<th>Sequence</th>
<th>Step</th>
<th>ID</th>
<th>Name</th>
<th>Status</th>
<th>Show</th>
<th>Time</th>
<th>D No</th>
<th>B No</th>
<th>R Type</th>
<th>Recipe</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

In the line representation of a sequence, the following information is displayed and the following operations are possible:

Figure 3-10

Window display

To open the faceplate click on the sequence icon in one of the process pictures.

Figure 3-11
The faceplate which subsequently opens displays most of the process relevant information and allows the basic control of the unit:

Figure 3-12

3.4.2 RCS Faceplate (for route control)

The faceplate is used to display the status and operation of a configured route.

Detailed view

To open the detailed view, click on the control with the left mouse button.

Figure 3-13

The route control faceplate opens.

Figure 3-14
This window consists of three sections from top to bottom:

- Route view
- Element view
- Message view

Figure 3-15 Route control faceplate complete window

**Route view**

In this view the active routes are displayed.
The full name of the element, name of source and destination are displayed as tool tips:

Figure 3-16 Route view from the detailed view window

**Element view**

The element view is similar to the RCS-online view but the columns “Feature” and “Function number” are grouped.

Figure 3-17 Element view from the detailed view window
To set a filter that will display only faulty items, click the funnel icon on the window. This will display all faults that affect operation and malfunction.

**Figure 3-18**

<table>
<thead>
<tr>
<th>Route</th>
<th>Mode</th>
<th>Partial Route</th>
<th>Object Mode</th>
<th>Feedback</th>
<th>Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>E1_05</td>
<td>1</td>
<td>83</td>
<td>Propagation</td>
<td>CLOSE</td>
<td>CLOSE</td>
</tr>
<tr>
<td>E1_05</td>
<td>1</td>
<td>829</td>
<td>Source B1</td>
<td>OPEN</td>
<td>OPEN</td>
</tr>
<tr>
<td>E1_10</td>
<td>1</td>
<td>833</td>
<td>Propagation</td>
<td>CLOSE</td>
<td>CLOSE</td>
</tr>
</tbody>
</table>

**Message window**

In the message window alarms are shown that originated from the plant section of the selected route.

Filtering by clicking on the funnel icon reduces the displayed messages again to faulty items only.

**Figure 3-19** Message window from the detailed view window

### 3.4.3 Individual Control Elements (ICM) faceplate

For the monitoring, control and simulation of Individual Control Elements (ICM), a particular faceplate is designed.

**Tab “General”**

The “General” tab gives an overview over the current state of the ICM and allows basic control over it.

**Figure 3-20**
4 Alarm System

4.1 Overview

Messages and alarms in the processes are displayed in a message window and archived on the hard disk.

For each message, separate texts for incoming and outgoing messages are available.

Figure 4-1
4.2 Message Control Faceplate

Features

- Display of messages
- Size and position freely configurable
- Filter tracing
- Messages are archived for 24 hours
- Jump from the messages directly to the corresponding process image
- Process unit related messages list

Figure 4-2

The ICM which caused the message is mentioned.

From the message faceplate it is possible to jump directly to the process images via right mouse button.

4.3 Messaging system

4.3.1 Message types

There are seven different types of messages in the BRAUMAT system:

- User Alarms
- System Alarms
- Warnings
- User Messages
- Operator Messages
- Operator Requests
- IOS-Messages
### 4.3.2 Message encoding

<table>
<thead>
<tr>
<th>Name</th>
<th>Color</th>
<th>Code letter</th>
<th>Purpose</th>
<th>Example</th>
</tr>
</thead>
<tbody>
<tr>
<td>User Alarm</td>
<td>Pink</td>
<td>„F“</td>
<td>Critical alarm</td>
<td>01:56:59 F filler line 4 000107 000001 026 035 filler line 4 026 REPORTS 0648 Flow supervision: flow below MIN Limit coming 02:35:50 F CIP HWA49 000015 000001 020 016 CIP FK HWA49 020 REPORTS 0031 Hold Mode is caused BY AUTOMATIC PROGRAM</td>
</tr>
<tr>
<td>System Alarm</td>
<td>Red</td>
<td>„S“</td>
<td>Critical alarm</td>
<td>00:15:03 S CIP UF LB32 000036 000001 020 002 CIP UF LB32 020 ICM3 0091 LB32ESV9304 ICM3-Supervision time elapsed</td>
</tr>
<tr>
<td>Warning</td>
<td>Yellow</td>
<td>„W“</td>
<td>Step time, monitoring time</td>
<td>18:04:20 S Dosage Dosimat14 000034 000010 021 009 Dosimat 14 021 error beginning 0020 DS14LE1414 Error: value below min.</td>
</tr>
<tr>
<td>User Message</td>
<td>Green</td>
<td>„M“</td>
<td>Raise operator awareness</td>
<td>00:02:01 W filter-line 3 000001 000001 023 001 KGF FL3 023 Unit 0001 KGF FL3 supervision-time error beginning</td>
</tr>
<tr>
<td>Operator Message</td>
<td>Blue</td>
<td>„B“</td>
<td>Sequence-related or route-control-related alarms</td>
<td>02:59:29 m Filterline 1 000017 000001 022 001 KGF FL1 022 REPORTS 0037 notifications maximum particle filter inlet pressure</td>
</tr>
<tr>
<td>Operator Request</td>
<td>Green</td>
<td>„O“</td>
<td>Operator advice</td>
<td>16:33:43 m of CIP KGF LB42 000072 000001 020 009 CIP FK LB42 020 ICM1 0036 HWS46ESV3449 ICM activated in the manual-mode</td>
</tr>
<tr>
<td>IOS - Message</td>
<td>Brown</td>
<td>„P“</td>
<td>Actions of the IOS</td>
<td></td>
</tr>
</tbody>
</table>
4.4 Message archive

Newly generated messages are displayed in the window of the PCU-Server and simultaneously each new message is logged in the "Message archive" which can be found in the section "Process archives".

The command “Select” from the “Functions” menu configures a filter to select the displayed alarms.

To filter the alarms which are to be displayed, use the “Functions” → “Select” entry from the main menu.

A dialog “Select data sets” opens.

Figure 4-3

The section “Field name” lists the available data record fields.

To employ a filter, select the required field (e.g. “Batch”) and enter the corresponding value (e.g. the batch number) in the field “Enter”.

Figure 4-4

NOTE The batch number must be padded with leading zeroes, e.g. to filter for the batch number “3”, enter “000003”.

Copyright © Siemens AG 2014. All rights reserved.
5 Curve visualization: "Trends"

The system can log measurements of specific values over a certain period creating so-called "Trends" from the measurements. These trend curves can be displayed with the application "Trending".

The values to be archived and displayed with the trend are defined thorough the application "Trending definition" from the tab "Engineering-Tools".

5.1 Types of Trends

BRAUMAT supports three types of trend curves:

- Short term trends:
  - User-selected collections of trend curves which are not stored on the hard disk
- Weekly archives (stored on hard disk)
- Batch archives (stored on hard disk)

**NOTE**

"Short-Time Curves" are also defined in the "Trending definition" application.

5.2 Selection of Trends

To select a curve to be displayed there are two options:

- Select "Open" from the "File" menu
- Press the button "Open image".

Figure 5-1
A dialog box opens which allows the selection of the relevant curves sorted by batch or week.

Features

- Each picture may contain up to eight analog and 16 digital curves in one picture.
- Each curve can be individually turned on and off.
- The operator can print snapshots of the curves.
- A zoom function serves to examine picture details.
- A ruler shows the exact process values and time.
- The scaling of the curve, physical units etc. are configured in the application "Trending definition".

There are different options to display the curves:

Figure 5-2

1. Normal View: The measured values are related to a batch id in a second step the user selects the batch id.
2. Compare Curves: The curve of the current batch is compared to the curve of a previously saved batch. Again, the user selects the batch id in a second step.
3. Free Selection: Allows you to superimpose up to eight batch curves in a single display. The selection is specific to the measured value, and will be used as reference for the selection "reference curves".
6 Starting and Watching Recipes

BRAUMAT contains an advanced batch and recipe system. A “Batch Scheduler” (see 6.1) is provided to create and start orders and batches in the easiest and most dynamic way.

**NOTE**
Basic concepts of batches and recipes are outside the scope of this document. Information regarding these topics can be found in the Automation system BRAUMAT/SISTAR Classic V6.0 Recipe System manual.

6.1 The Batch Scheduler

6.1.1 Creating an Order with the Batch Scheduler

Table 6-1

<table>
<thead>
<tr>
<th>No</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>To start the Batch Scheduler, double-click on its icon in the “Process monitoring” tab.</td>
</tr>
<tr>
<td>2.</td>
<td>From the application’s main menu, select “Edit” → “New order” to open a dialog which allows you to configure new batches.</td>
</tr>
</tbody>
</table>
6.1.2 Starting an Order

The Batch Scheduler will enter all batches of the newly created order in the batch list. Newly created orders are usually locked initially.

Table 6-2

<table>
<thead>
<tr>
<th>No</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>To start an order, double click on the corresponding item in the batch list. This opens the “Change batch status” dialog. You can change the status of an individual batch and of all batches which are part of the selected order.</td>
</tr>
<tr>
<td>2.</td>
<td>The first batch that is released will start as soon as its process start condition is set to true.</td>
</tr>
</tbody>
</table>

6.1.3 Supervising Batches with the Batch Scheduler

In addition to creating orders the Batch Scheduler offers several tools to supervise task lists and batches.

To open any of the tools, select the corresponding command from the Batch Scheduler’s “File” menu or press the appropriate hotkey.

Figure 6-1
Batch List

When the toolbar button for the batch list is pressed a filter definition dialog window is shown. Here the criteria for the displayed batches (e.g. order type, batch status) can be set to reduce the number of listed batches according to the operators need.

Figure 6-2

Batch Tracking List

The batch tracking list is a most valuable feature which allows you to monitor the status of all units involved in the selected batch(es).

The picture below shows which units are allocated or waiting to be allocated by each batch. The first batch will after it has started first allocate the “FBS Machine” and then the “FBS Process” units while the batch in the second row will allocate the “Blending” unit only.

Figure 6-3
6.2 Watching Recipes with the Control Recipe Editor

The “Control Recipe Editor” displays the online status of recipes.

Launching the Control Recipe Editor

The following table describes how to launch the Control Recipe Editor:

<table>
<thead>
<tr>
<th>No.</th>
<th>Action</th>
</tr>
</thead>
</table>
| 1.  | To start the Control Recipe Editor, use either the main menu entry “Process monitoring” tab → “Control recipe” or “Process monitoring” → “Sequence controller”.
| 2.  | If the “Control Recipe Editor” is opened directly from the BRAUMAT menu application the operator has to select the batch to be displayed in the tree view. |
3. If the "Control Recipe Editor" is started by pressing the "F9" button in the sequence controller window it displays the control recipe of the batch that is running on the unit that was selected in the sequence controller application. No further batch selection is necessary in this case.
7 Development of Process Pictures

7.1 File Structures for BRAUMAT Process Pictures

Two files are associated with each process image displayed within BRAUMAT runtime:

Table 7-1

<table>
<thead>
<tr>
<th>Type</th>
<th>Extension</th>
<th>Contents</th>
</tr>
</thead>
<tbody>
<tr>
<td>ASCII</td>
<td>&quot;*.bik&quot;</td>
<td>• Link to the background (see below)</td>
</tr>
<tr>
<td></td>
<td></td>
<td>• Tag list</td>
</tr>
<tr>
<td>Image</td>
<td>&quot;<em>.bmp&quot;,&quot;</em>.jpg&quot;</td>
<td>• Static background image</td>
</tr>
</tbody>
</table>

Consequently developing a process image consists of two steps:

- Creating a tag list
- Providing a background image

7.2 Creating a Tag List

To create a tag list, start the “BiKo” editor from the “Main Menu” → “Engineering Tools (Tab)” → “Image Design”.

7.3 Background Image and Predefined Static Objects

- Background images for BRAUMAT can in principle be created with any drawing software like CorelDraw. Yet there are a few specific advantages when using the WinCC Graphics Designer.
- WinCC GD facilitates the rapid creation of background images with no previous graphics tool experience required.
- WinCC GD offers a tube objects tool with which pipes will simply be placed and scaled on a separate layer in the image. This is much quicker than work with conventional graphics diagrams.
- The time consuming task of drawing basic objects isn’t required with WinCC GD. WinCC GD provides a library of static objects (like equipment, valves or tanks) in the shape of vector-graphics. These can be inserted in the image on a separate layer and may be scaled as required. (See 7.3.6, Static Process Devices)
- Completed images are stored as WinCC GD-files ("*.pdl" extension) and can be exported to a bitmap based format in a final step. (See 7.3.7, File conversion between applications).

NOTE: In the following chapter it is assumed the user is working with the WinCC Graphics Designer.
7.3.1 Using Layers in Graphics Designer

Graphics designer offers up to 31 layers for placing objects into the process picture. We recommend the following organization of layers:

Table 7-2

<table>
<thead>
<tr>
<th>Layer</th>
<th>Content</th>
</tr>
</thead>
<tbody>
<tr>
<td>25</td>
<td>Unit faceplates and picture links (navigation)</td>
</tr>
<tr>
<td>20</td>
<td>Dynamic objects (control modules, controls, analogue values and other tags)</td>
</tr>
<tr>
<td>15</td>
<td>Static text and pipes on vessels</td>
</tr>
<tr>
<td>10</td>
<td>Static vessels, tanks, equipment and so on</td>
</tr>
<tr>
<td>5</td>
<td>Static pipes</td>
</tr>
<tr>
<td>0</td>
<td>Wallpaper (background pattern, labels, trade-marks and so on)</td>
</tr>
</tbody>
</table>

7.3.2 Image resolution of process pictures

The following table gives an overview of the applied resolutions:

Table 7-3

<table>
<thead>
<tr>
<th>Item</th>
<th>Message class</th>
<th>Resolution</th>
</tr>
</thead>
<tbody>
<tr>
<td>1</td>
<td>Monitors at operator stations</td>
<td>1280 x 1024 pixels</td>
</tr>
<tr>
<td>2</td>
<td>Touch Panel</td>
<td>n/a.</td>
</tr>
</tbody>
</table>

7.3.3 Substance and piping graphics conventions

The following graphics shows the coloring and style conventions for materials and piping.

Figure 7-1
The following table shows the HTML Color codes to be used for specific materials.

Table 7-4

<table>
<thead>
<tr>
<th>Material</th>
<th>HTML-Code</th>
</tr>
</thead>
<tbody>
<tr>
<td>Acid</td>
<td>FFC7FF</td>
</tr>
<tr>
<td>Air</td>
<td>0080FF</td>
</tr>
<tr>
<td>Ammonium</td>
<td>9A009A</td>
</tr>
<tr>
<td>Caustic</td>
<td>F5AEFF</td>
</tr>
<tr>
<td>CIP</td>
<td>FA80FF</td>
</tr>
<tr>
<td>CO2</td>
<td>8080FF</td>
</tr>
<tr>
<td>Cold Water</td>
<td>00CE00</td>
</tr>
<tr>
<td>Condensate</td>
<td>FFA5A5</td>
</tr>
<tr>
<td>Disinfection</td>
<td>FFE6FF</td>
</tr>
<tr>
<td>Dust</td>
<td>B6B6B6</td>
</tr>
<tr>
<td>Hops</td>
<td>009D67</td>
</tr>
<tr>
<td>Hot Water</td>
<td>008500</td>
</tr>
<tr>
<td>Malt</td>
<td>FFC300</td>
</tr>
<tr>
<td>Mash</td>
<td>FFC599</td>
</tr>
<tr>
<td>Spent Grain</td>
<td>FFCE09</td>
</tr>
<tr>
<td>Steam</td>
<td>FF0000</td>
</tr>
<tr>
<td>Sugar</td>
<td>FFFFFF</td>
</tr>
<tr>
<td>Trub</td>
<td>A5A500</td>
</tr>
<tr>
<td>Wort</td>
<td>FFA100</td>
</tr>
<tr>
<td>Yeast</td>
<td>FAFFEF</td>
</tr>
</tbody>
</table>

These templates are available in the file “@@BB_TemplatePipes.PDL”.

7.3.4 Process connectors

Connectors are drawn in one of two ways:

- To indicate incoming process media: A connector on the left side of a process image with an arrow pointing to the right at the beginning of a pipeline. (See below)
- To indicate outgoing process media: A connector on the right side of a process image with an arrow pointing to the right at the end of a pipeline. (See below)

Table 7-5

<table>
<thead>
<tr>
<th>P &amp; ID</th>
<th>Process picture</th>
</tr>
</thead>
<tbody>
<tr>
<td>Product feed / CIP</td>
<td><img src="image" alt="CIP/SP" /></td>
</tr>
<tr>
<td>To solid tank</td>
<td><img src="image" alt="Solid Tank" /></td>
</tr>
</tbody>
</table>
7.3.5 Static Texts

A number of text fonts and formats are predefined for use in your projects.

Table 7-6

<table>
<thead>
<tr>
<th>Text function</th>
<th>Font</th>
<th>Size</th>
<th>Color</th>
<th>Style</th>
</tr>
</thead>
<tbody>
<tr>
<td>Tag names</td>
<td>BLACK</td>
<td>11</td>
<td>Black</td>
<td>Bold, UPPER CASE</td>
</tr>
<tr>
<td>Normal or general text</td>
<td>Arial</td>
<td>10 or 12</td>
<td>Black</td>
<td>Regular, Mixed case</td>
</tr>
<tr>
<td>Image Title (positioned at x=5, y=40)</td>
<td>BLACK</td>
<td>24</td>
<td>Black</td>
<td>Bold, Title Case</td>
</tr>
<tr>
<td>Button text (enabled)</td>
<td>Arial</td>
<td>12</td>
<td>Black</td>
<td>Regular, Title case</td>
</tr>
<tr>
<td>Button text (disabled)</td>
<td>Arial</td>
<td>12</td>
<td>Mid Grey</td>
<td>Sunken, Title case</td>
</tr>
<tr>
<td>Links to other mimics</td>
<td>Arial</td>
<td>12</td>
<td>Black</td>
<td>Regular, Title case</td>
</tr>
<tr>
<td>Dynamic values</td>
<td>Arial</td>
<td>15</td>
<td>Dark Green</td>
<td>Regular, Mixed case</td>
</tr>
<tr>
<td>Static values/units</td>
<td>Arial</td>
<td>12</td>
<td>Black</td>
<td>Regular, Mixed case</td>
</tr>
<tr>
<td>Device number</td>
<td>Arial</td>
<td>Variable</td>
<td>Dark Blue</td>
<td></td>
</tr>
</tbody>
</table>

7.3.6 Static Process Objects

A library of pictures of static process objects is provided in the shape of an MS-Visio file with the name “G33308-#99001-F211-nn_OS-TemplateStaticObjects.vsd”.

The static objects are organized in different sheets grouped according to the devices they contain. The various groups are:

- Equipment 1 and 2
- Tanks and Silos
- Vessels
- Conveyors and Others

**NOTE**
The Visio objects can’t be directly used in the WinCC Graphics Designer but must be exported and converted first. See 7.3.7, file conversion between applications for details.
Equipment 1 and 2

Figure 7-2
Figure 7-3
Tanks and Silos

Figure 7-4
Figure 7-5
7 Development of Process Pictures

Vessels

Figure 7-6
Conveyors and Others

Figure 7-7
7.3.7 File conversion between applications

MS Visio, the WinCC Graphics Designer, and BRAUMAT use file types which are not mutually compatible. To work with the static objects library files must be exported and converted between applications.

Figure 7-8
Exporting static objects from a Visio "*.vsd"-File to Graphics Designer as "*.emf"-Files via macro ("1. Export")

To use the static library objects in the WinCC Graphics Designer the objects must first be converted from a Visio "*.vsd" file to an "*.emf" file in a separate folder. The conversion is done via a macro which is part of the Visio "*.vsd" file.

**Table 7-7**

<table>
<thead>
<tr>
<th>No</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>To export the Visio objects, open the Visio &quot;*.vsd&quot; file and the start the macro from the main menu with the &quot;tools&quot; → &quot;Macros&quot; → &quot;ShapeExport&quot; → &quot;ExportToShape&quot; command.</td>
</tr>
<tr>
<td>2.</td>
<td>The macro will open a dialog asking for a destination folder name. The selected shapes will be stored as &quot;*.emf&quot; files in that directory.</td>
</tr>
<tr>
<td>3.</td>
<td>Copy the files with the exported static objects into your (multi-) project file directory &quot;(drive name)...\wincproj\ (NameOfServerOS)\ GraCS&quot;</td>
</tr>
<tr>
<td>4.</td>
<td>All required static objects can now be combined into a &quot;*.pdl&quot; file.</td>
</tr>
</tbody>
</table>

**NOTE**

In addition to the static objects created through the Visio-export a file with tube templates will be generated with the name "@@BB_TemplatePipes.PDL".

The pipes in this file are predefined tubes created with "Graphics Designer" tool → "Object Palette" → "Tube objects" with their design according to the material and piping graphics conventions (see 7.3.3).
Conversion from Graphics Designer “*.pdl” format into bitmap format (“2. Export”)

BRAUMAT can import images only in either “*.bmp” or “*.jpg” format but Graphics Designer is unable to produce these directly. Therefore a two-step conversion process between both applications is required. This conversion uses “*.emf” as an intermediate file format between “*.pdl” and “*.bmp”/*.jpg”.

Table 7-8

<table>
<thead>
<tr>
<th>No</th>
<th>Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>1.</td>
<td>Click the WinCC Graphics Designer menu entry “File” → “Export…” to export the current images as an “*.emf” file.</td>
</tr>
<tr>
<td>2.</td>
<td>Open each “<em>.emf” file created that way with a suitable bitmap based graphics software and save it again, using the “Save as” command and changing its file type to “</em>.jpg” or “*.bmp” in the process.</td>
</tr>
<tr>
<td>3.</td>
<td>The resulting “<em>.jpg”/</em>.bmp” background images can now be imported in BRAUMAT.</td>
</tr>
</tbody>
</table>

**NOTE**
Microsoft Paint is a suitable application capable of performing the required conversion.
NOTE

JPG produces much smaller files than BMP and requires only between approximately 3% and 10% of the storage space of a comparable BMP.

But since the compression is “lossy”, JPG may introduce artifacts into a picture which distort the original image (see below). This behavior may be controlled to some extent by adjusting the compression parameters of the JPG export.

Decide which format you use on a case-by-case basis.

Table 7-9

<table>
<thead>
<tr>
<th>BMP (uncompressed)</th>
<th>JPG (strong compression)</th>
</tr>
</thead>
<tbody>
<tr>
<td>![BMP Image]</td>
<td>![JPG Image]</td>
</tr>
</tbody>
</table>
8 History

Table 8-1

<table>
<thead>
<tr>
<th>Version</th>
<th>Date</th>
<th>Modifications</th>
</tr>
</thead>
<tbody>
<tr>
<td>V1.0</td>
<td>01/2014</td>
<td>First version</td>
</tr>
</tbody>
</table>